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Introduction 
 

Tax Professional allows you to create an unlimited number of tax returns for individuals 

and partnerships.  Returns can be created from scratch or based on the previous year’s 

return.  Tax Professional has a built in internet filing module, which installs with the 

software. 

 

Starting Tax Professional 
 

Open Client Manager and click the Tax 2014 button from the Programs group in the 

Navigation Pane; you will be presented with the following screen: 

 

 

If this is the first time you have used Tax Professional this screen will contain only the 

demo tax return details, if you have used Tax Professional already then your clients and 

returns will be displayed. 
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Sorting and Filtering Clients 
 

In the bottom of the Open Tax Return Screen you have several options for sorting and 

filtering clients:  

 

Filter Clients by Type: In the Select Type of Client frame click either Individual to see 

SA100 clients only, Partnership to see SA800 clients only or both to see both client 

types.  

Filter Clients by Tax Year:  In the Select Tax Year frame click the tax year you wish to 

work with; clients with returns in that year are then displayed, or click All to display all 

clients. 

Sort Client List:  You can sort clients by clicking the drop down in the Sort List By field 

and selecting one of the options.  You can present clients in either ascending or 

descending order by clicking AZ or ZA buttons. 

Search for a Client:  To search for a return first click Search for Return, in the Search 

for field type the client name or part thereof and click the Search button.  To cancel the 

search results click the Cancel Search button, which appears to the right of the Search 

button. 

Tip:  When you first install Tax Professional you may find a welcome screen keeps 

appearing when you start the application, to suppress the welcome screen uncheck the 

Show Help on Startup option in the bottom centre of the Open Tax Return screen. 

 

Print Summary and Print Proforma Letters 

 

Print summary presents various print options; you can select any combination of options 

and produce a report.  Check the Select and print Proforma's option to select a range of 

clients and generate proforma letters: 
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Click the Print button, select the required clients and click Print, the proformas will 

appear initially on screen, click the Print button on the top left.  Note that each proforma 

consists of a letter and checklist (2 pages). 

To amend the proforma letter open any tax return, click the Tools menu then Amend 

Proforma Letter and amend the wording, click Save and Exit. 

Converting Returns from Previous Years 
 

If you have created tax returns using an earlier version of Tax Professional these returns 

can be automatically brought forward into this year’s version of the software.  You will 

be prompted as part of the year end process to create tax returns for all active clients, 

click Yes to create tax returns for the new year.  If you click No you can create tax 

returns for the new tax year by clicking on the individual’s previous year’s return. 

The current year return is created based on the previous year return.  The original return 

is retained and you will see the return listed for each of the years. 

 

Maintaining Client Details 

 

From the Open Tax Return screen you will notice two other tabs; Client Details and Utils 

(we discuss utils later in the manual), click the Client Details tab; you can enter details 

into any enabled field, the detail in the disabled fields comes from the main tax return.  

 

Creating a New Client 

 

You create clients in Client Manager and add jobs to clients by selecting job types in the 

Jobs frame of the Practice tab in the client record.  Adding an SA100 job and selecting a 

tax year to a client record (or an SA800 job to create a partnership return) will make the 

client available in the Tax module and create a tax return for the year specified.  

Alternatively, you may create the client in the Tax module and either add the client or 

link it to an existing record in Client Manager.  To create the client in the Tax module 

click the Create Return button in the Open Tax Return screen, the following options are 

presented: 



 
0845 456 3103 support.keytime.co.uk 

 

First select the tax year, note that it is possible to create returns for previous and next 

tax years in addition to the current tax year.  To create a self assessment return 

(SA100) click Create a Tax Return (Quick option), to create a partnership return click 

Create Partnership Return.  The Launch Interview option is only recommended for users 

that are unfamiliar with tax returns, i.e. individuals that are completing their own self 

assessment return.  Click Create. 

Instructions from here onwards assume you are working with an SA100 return, 

for details on partnership returns please see the Partnership section. 

In the Personal details tab: 

1. To link the client to an existing client record in Client Manager click the Link to 

existing client button to the right of the Client ID field.  You will be presented with 

a list of individual and sole trader clients who don’t currently have an SA100 job, 

double click the client record you want to link to.  If you do not want to link to an 

existing client record, enter the client ID  

2. Fill in the rest of the personal details. 

3. Click Personal Details Cont. and fill in the remaining client details, please note 

that you cannot file a tax return without a UTR; you can create the return without 

it, but you will not be able to file until you have the correct client UTR. 

 

Creating Returns for Previous Tax Years 

 

You can create a tax return for a prior tax year based on the header information in the 

current year tax return.  To create a return for a prior year proceed as follows: 

 

 Open the current year return of the client you need to create the return for 

 Click the File menu, select Create previous return 

 Choose the tax year you need to create (the list contains missing years) 

 

Adding Supplementary Forms 

 

Click the Tax Return Forms tab and select the required supplementary forms and 

number of copies.  It is possible to add/amend these pages once the return has been 

started, we shall cover this in a later section. 
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The Tax calculation summary pages are always included by default as they are required 

for filing by internet; do not remove these pages unless the return is to be filed on 

paper.  

Navigating Tax 
 

Navigation Tree 

 

The pages of the return can be found in the navigation tree down the left of the main 

screen: 

 

Minor Toolbar 

 

At the top of the left hand navigation tree are seven small (or minor) icons: 

 

+  Expands all items in the Navigation tree 

-  Collapses all items in the Navigation tree 

Tick Marks selected pages of the return as complete, for your own reference 

only 

X  Marks selected pages as incomplete, for your own reference only 

Notes  The Notes button allows general notes to be entered 
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Check The Check button launches the return validation routine (checks for errors 

before internet filing but can be used generally to check for errors in the 

return) 

Tax Year You can access tax returns from previous years by clicking the dropdown 

button and selecting a return from the list 

 

Menu Bar 

 

The menu bar consists of the following: 

File – Contains options for opening, creating new and deleting returns as well as storing 

agent details and registering the software.   

Edit – Copy, cut and paste, options for deleting unwanted supplementary pages and 

changing the status of a return. 

View – A selection of reports and schedules. 

Rapid Data Entry – Data entry screens for tax return sections and pages as well as 

options for 64-8, SA303 and R40. 

Tools – Contains tools for internet filing, amending proforma letters, options for 

importing data from external sources, create next year’s tax return and various system 

configuration options.  

Help – Software help file, HMRC notes, weblinks and updating options, licence 

agreement and software and system information. 

 

Main Toolbar 

 

In addition to the drop down menus there is a main tool bar, which looks like this: 

 

We will address the Normal, Data Entry and Preview Mode buttons a little later in this 

section. 

Back and Forward Buttons:  Move between sections and pages, using these buttons at 

the end of every page you will be prompted to mark that page is complete, note that this 

option affects only the appearance of the pages as they are listed in the navigation tree 

(down the left of the main screen) and has absolutely no affect on the completeness of 

the return; it is not necessary to mark all the pages as complete before filing your return. 

Start:  Click Start to go back to the Open Tax Return screen without closing the application 

completely. 

Client: Click Client to return to the tax form details. 
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Data Entry:  Opens the current page in data entry mode. 

Save:  Saves changes. 

Print:  Launches various options for printing the tax return. 

Calculate:  View a breakdown of the computation and total tax and NI due.  You can 

also see an estimate of next year’s computation from this screen. 

Exit:  Closes the application 

 

Data Entry and Data Views 
 

The system has 3 separate modes for entering / reviewing data on screen: 

 

Normal 

Rapid Data Entry (not available in partnerships) 

Preview 

 

Use the icons on the toolbar in the top left hand corner of the screen to switch between 

these modes 

 

Normal Mode 

 

Normal mode is selected by default and basically offers the user an intelligent form filler 

mode for data entry 

For some clients it may well be that this mode can simply be used for completing the 

entire return 

Use the Navigation Pane on the left hand side of the screen in conjunction with the 

Back and Forward buttons on the toolbar to move through the tabs and pages, 

capturing data by entering figures and text in appropriate boxes.   

 

Rapid Data Entry Mode 

 

Whilst normal mode is possibly the best (and quickest) data entry method for certain 

clients (and specific sections of the tax return) this isn’t always the case. 
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Data Entry mode provides a more comprehensive means of capturing data, especially for 

areas such as Employment, and Capital Gains.  Data Entry allows the user to enter 

transactions that make up totals and to make use of certain calculators. 

Click the Data Entry button on the main toolbar. 

Note that the sections of the tax return remain visible on the left hand navigator tree, 

but that the individual pages are no longer displayed.  The buttons on the minor toolbar 

are also disabled. 

Click on a section in the navigation tree to launch that section in data entry mode.  In 

this instance, we shall use employment pages to demonstrate data capture in data entry 

mode. 

Click Employment in the navigation tree 

The Employment Rapid Data Entry Screen is displayed: 

 

In the above sample screen, in addition to text boxes for employers name and address 

etc. a series of tabs are displayed related to various aspects of employment, click on the 

tab heading to move between tabs. 

Data is captured in some of these tabs in the form of a grid, in addition to this there are 

various calculators, note the Vehicles button in the right of the window, this calculates 

the taxable benefit of a company vehicle.  These calculators can be found in other 

sections when working in data entry mode and are used to calculate taxable benefits and 

reliefs. 

Grids are displayed as in the screen below: 
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Use the Add key to add a line to the grid, and the Delete key to remove a line and its 

data. 

In some fields, for example the Type field in the screen above, you will find a drop down 

menu, which enables you to select a relevant item to add to the grid.  Other fields, such 

as the Description and Date fields in the screen above are text fields (not all text fields in 

data entry mode are necessary for the completion of the tax return, but may be used for 

your own reference). 

Note the Copy Number field in the bottom right hand corner of the screen. This is used 

where there are multiple supplementary pages, in this example, more than one 

employment.  Click the back and forward arrows either side of the copy number to move 

between copies. 

 

Using Calculators 
 

Calculators are available when working in data entry mode, you will find various 

calculators in their relevant sections of the return, for example, car benefit in the 

employment pages and capital allowances in the self employment pages. 

 

Car Benefits Calculator 

 

Car benefits are entered using the car benefits calculator only when working in data 

entry mode.  Click the Vehicles button in the Employment section and proceed as 

follows: 



 
0845 456 3103 support.keytime.co.uk 

 

Enter the vehicle make and model in the field at the top of the screen.  Work through the 

items on screen entering and selecting data, note there are two tabs.  There is a link to 

an emissions website if you do not know the CO2 emissions for the vehicle.   

If there is more than one vehicle in this employment, click the Add button in the panel to 

the right of the window and a second line will appear onto which details of the second 

vehicle can be entered.  Where there are other vehicles that relate to other employments 

you must move to a second supplementary page and use the car benefit calculator 

there.  This procedure is repeated for third and subsequent vehicles.   

Click the Totals button to view a summary of the information entered.  Click the Return 

button to go back to the Employment Rapid Data Entry Screen. 

 

Capital Allowances 

 

The capital allowances calculator can be accessed from the Self Employment data entry 

screen and from page 2 (short pages) or page 3 (full pages) on the Self Employment 

pages. 

In Data Entry mode, click Self Employment on the navigation tree, click the Capital 

Allowances tab and click the Capital Allowances button.  In Normal mode, click Self 

Employment on the navigation tree, click page 2 (short pages) or page 3 (full pages), 

click the Capital Allowances button, the following screen is presented: 



 
0845 456 3103 support.keytime.co.uk 

 

Asset pools and AIA summary are shown in the top half of the screen, as you click on a 

pool type capital allowance calculations are shown in the bottom half of the screen.  

There are also options to cease the pool, cease the company and claim small pool 

allowance. 

Adding an Asset 

 

To add an asset to a pool, click Add, the following screen is presented: 

 

 

 Enter a description for the asset. 
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 If the asset is a car, click the Add Car button: 

 

 

 

 To assign the car to the correct pool and work out the correct allowance based on 

CO2 emissions tick the appropriate boxes.   

 Click Close when you are finished to return to the main screen, the car details will 

be added to the appropriate pool; you will see that the pool type may have 

changed and that it is disabled. 

 Enter the date acquired in the asset date. 

 In the Details frame enter the relevant information about this asset. 

 Some of the asset details won’t be available in all the pools, tick the asset details 

as appropriate. 

 To make best use of AIA, you can apply the allowance to particular asset 

additions; enter the AIA value if appropriate. 

 You can obtain an AIA summary by clicking and AIA Summary button, this shows 

the asset description, the pool, the WDV rate and the AIA value. 

 Once you have finished entering the asset details, click Save and Close to return 

to the main screen. 

 Back in the main screen, you will see that each pool in use becomes visible in a 

tab on the screen, click on an asset to see the allowance details for the pool in 

the frame below. 

 You can amend the allowance claimed by amending the WDA used, click the box 

to amend WDA used, enter the amount you wish to claim and click the Calculate 

button to the right of the field to apply the change. 

 Double click any of the individual assets to return to the asset details. 

 

Ceasing Assets and Pools 

 

 To cease an asset locate the asset in its pool and double click it. 

 Click the Cease Asset box in the bottom right of the screen. 

 To cease a pool, click any asset in the required pool and click Set pool to ceased 

in the bottom right of the screen. 

 If the company has ceased, click Company has ceased; this will cease all pools. 
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De-Pooling Assets 

 

You may treat an already pooled asset (other than a car) as a short life asset (make a 

de-pooling election).  The asset can be transferred to the short life pool where it will be 

treated as an individual asset.  The system will also count the number of chargeable 

periods the asset has been in the short life pool. 

To de-pool an asset, proceed as follows: 

 If you have the asset already in another pool, you can transfer it to the short life 

pool.  Locate the asset and double click it to open the asset details, change the 

asset category (pool).   

 The system will flag the asset as short life and assign a chargeable period of 1, 

this being the first chargeable period the asset has been in this pool.  At year 

end, the asset will be brought forward and the chargeable period incremented to 

2 and so on.  The chargeable period can be amended. 

 If you are adding an asset and electing to de-pool, add the asset to the short life 

pool and the system will automatically flag it as short life and assign a chargeable 

period of 1. 

 To re-pool an asset, locate the asset in the short life pool and click re-pool asset, 

this will transfer the asset back to the general pool. 

 

Claiming Small Pool Allowance 

 

Where the balance on the main or special rate pool before calculating WDA is £1000 or 

less the balance may be claimed as the WDA.  To claim small pool allowance, first click 

an asset in the pool, in the main screen click the Claim Small Pool Allowance box, this 

will write off the balance in that pool. 

When you have finished entering capital allowances click the Close button and take the 

option to send the results to the return. 

 

Capital Gains 

 

Click Capital Gains Summary from the navigation tree, the following screen is 

displayed: 
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 Enter the description of the gain in the description field and select the type of disposal 

from the drop down menu, enter the date of acquisition and date of disposal, cost of 

acquisition, incidental acquisition expenditure, disposal proceeds and disposal costs.   

 To add enhancement costs, click the cost of enhancement box; an additional tab will 

be added to the screen, enter the enhancement(s) details and cost and click the 

Calculator button to refresh the total cost of enhancements.  This figure is returned to 

the cost of enhancements field in the Details tab. 

 To claim reliefs/elections click the claiming reliefs/elections box and enter the relief 

description and amount.   

 Click the Losses/Entrepreneurs’ Relief tab to specify the type of asset (business/non 

business asset or mixed use), claim losses and entrepreneurs’ relief.  Click the 

Entrepreneurs’ Relief button (bottom left) to view a breakdown of entrepreneurs’ 

relief. 

 Click the Additional Details button (bottom left) to enter attributed gains and 

general text information for the pages in the return. 

 Click the Add button to insert details of further disposals as applicable. 

 To delete a disposal entry, click the entry in the list of disposals and click the Delete 

button. 

 The generate R40 (CG) click the R40 button, click Refresh to bring details from the 

return to the R40.  Click through the tabs, or click the Next button to review or enter 

details for the R40.  Click Print to print the R40 report, click Finish to commit any 

changes and return to the main Capital Gains screen. 

 Click the Totals button to view a computation summary, click Return to move back to 

the rapid data entry screen.   

 Click Print to print the Capital Gains report 

 Click Attach to add the capital gains report to the list of attachments to be filed with 

the tax return. 

 Click Finish once all applicable disposals have been entered to return the details to 

the pages in the tax return. 
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Multiple Chargeable Gains Entries 

 

Multiple chargeable gains are located on page one of the Additional Information pages, 

also in the Life Insurance Gains tab when working in data entry mode. Click this section 

of the tax return; click Multiple Gains, the following screen is displayed: 

 

 

Click Add to enter multiple lines to the grid and capture multiple entries.  Select the type 

of gain from the drop down list, enter details.  Click Add to add further lines to the grid. 

Click Finish to populate boxes 4 – 10 of the Additional information pages. 

 

Dividends Database 

 

Tax Professional incorporates a dividend database.  The database contains FTSE 100 and 

250 UK shares from the 2013/14 tax year and can be found in page 3 of the main tax 

return and in page 1 of the Additional Information pages.  Click the Dividends button, 

the following screen is presented: 
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 Click Select Share and select the company.   

 Enter the share holding in the Holding boxes, if the shares have been held for the 

whole tax year, enter the total share holding and click Held shares for the year,  

 Click Save to add the share holding to the list. 

 You can add listed companies by clicking the Select Share button and click Add: 

 

 

 Enter the company name and ISIN number and a description of the share 

class. 

 Enter the dividend payment dates and price per share.  Tick the gross box if 

paid gross. 

 Click Save and Close to return to the main dividend screen. 

 Click Close to return the dividend to the tax return. 

 

 

Updating the Return 

 

Once you have finished capturing data to a particular section in data entry mode you 

must update the tax return form with the results, to do this click Finish.  To review the 

results in the tax return click the Normal button on the main toolbar, you will see the 

results have been transferred into the relevant boxes in the return. 

It is possible to enter some data in Normal mode and some data in Data Entry mode, for 

example, you may wish to make use of the calculators in data entry.  You can move 

between data entry and normal at any time, however, it must be pointed out that if you 

have made entries in normal mode and then you move to data entry mode you will find 

that the entry you made in normal mode does not appear anywhere in the data entry 

screens.  With this in mind a degree of caution is needed as it is possible to end up with 

a situation where you have entries in boxes in normal mode and different entries in the 

grids in data entry mode.  To counteract this you must click the Finish button when 

working in data entry mode; this will overwrite any entries that have been made to the 

affected boxes in normal mode.   
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Adding/Deleting Supplementary Pages and Copies 
 

It is possible to add and remove supplementary pages once the tax return has been 

started, proceed as follows: 

To Add Supplementary Pages or Copies 

 

Click the Client button on the main toolbar; you will be taken back to the tax form 

details.  Click the Tax Return Forms tab and select the supplementary form you wish to 

add, enter the number of copies required.  If you need extra copies, just increase the 

number of copies of the relevant supplement.  Click Finish and the pages will be added. 

To Delete Supplementary Pages or Copies 

 

Click the Edit menu, select Delete Supplement, select the supplementary page to delete 

then select the copy to remove. 

   

Reviewing and Filing the Return 

Computation 
 

Once data entry is complete, click the Calculate button on the main toolbar 

Note that there is an option by default to launch the Keytime website to search for 

program updates, selecting Launch will take you to the system where available updates 

can be downloaded.  You can suppress this message if you wish. 

An overview of the tax computation will be displayed: 
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Click Back and Next to move between the tabs.  Click the Preview button to view the 

SA302 (which can also be printed from this screen). 

 In Section 9 you will find Payments on Account and also an option to estimate tax 

due for the next year. 

 

Payments on Account 

 

Tax 2013 features payment on account history and a calculation for the current year 

based on the previous year’s liability.  You can access Payments on Account by clicking 

the button on page 1 of the tax calculation summary, or in section 9 of the income tax 

calculation (click Calculate on the main toolbar).  The following screen is presented:  

 

Please note that when viewing payments on account it is assumed  that payments on 

accounts due in the previous year have been paid, whether the previous year payments 

have been entered or not.  Based on this assumption the payments that were due last 

year are brought forward at year end into the payments already made box on page one 

of the tax calculation summary.  

When first loaded the grid will display the liability and payments for the current and next 

tax year, to view history for previous years, click the tick box on the top right of the 

screen. 

Below the grid, the payment schedule shows payments for the current year (tax year 

just passed); this can be varied by clicking the drop down and selecting a previous year. 

You can record payments on account made by ticking the Override box on the end of the 

line, enter the payments in the 31 Jan (POA paid) and 31 July (POA paid) boxes.  Un-

ticking the override box will set the boxes back their original state. 
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If there is employment income in this tax return, and box 2 on page five of the main 

return is not ticked, any remaining liability less than £2000 will appear in the PAYE code 

field. 

Any claim to reduce payments on account, entered directly into box 10 on page 1 of the 

tax calculation summary or in the SA303 wizard will replace payments due for the next 

year; the reduced payments will be displayed in red. 

You can print a summary report by clicking the Print button on the bottom left of the 

screen. 

 

Preview Mode 

 

Preview mode enables the actual tax return sections to be previewed on screen. 

Click Preview in the main toolbar, and then click the appropriate page of the tax return 

in the navigation tree.  Use the Back and Forward buttons on the main toolbar to move 

through the pages and supplements and review the return.  Note that preview mode is 

for review purposes only; you cannot make changes to data in preview mode. 

 

Viewing and Printing Reports 

 

Various plain paper schedules and computations can be printed from the Reports menu, 

as well as the tax return itself, either with or without accompanying schedules. 

Printing the Main Tax Return 

 

Click the Print button on the main toolbar or click the Reports menu, then Tax Form, the 

following screen is presented: 
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Click the required page(s) or schedule(s) then click the Preview button in the right of the 

window to preview the report on screen, or click the Print button to send directly to your 

printer.  

Specific schedules can be individually previewed and printed by selecting the appropriate 

option with the Reports menu, for example a summary computation or self employment 

plain paper schedule etc. 

 

Forms R40, SA303 and 64-8 

 

Forms R40, SA303 and 64-8 can be printed by clicking the Reports menu, then R40 or 

SA303. 

There are Rapid Data Entry Screens for the R40 and SA303 within the Tools menu. 

Additional reports and in particular tax calculations can be found by clicking the Reports 

menu. 

 

Internet Filing Management 

 

Tax has built in functionality for internet filing of returns.  Click Submit on the main 

toolbar, the following screen is presented: 
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Options are: 

Registration 

 

Before you can file tax returns you need to register for the service with the Government 

Gateway.  There is a link to the gateway in the internet filing screen and instructions on 

how to register can be found on the site.  If you have filed other types of returns by 

internet, for example, P35’s, then you will need to add self assessment returns to the list 

of items you are filing.  If you are filing partnerships, ensure you register for this service 

too.  Please see the Government gateway for more information and instructions.   

Important Note:  Registration is not instantaneous; you need to register in plenty of 

time before the filing deadline. 

Click Add Details to enter your user ID and password.  Click I am an Agent if you are 

filing on behalf of someone else. 

Click Agent Details to produce a form 64-8 

Username/Password 

 

Store your Gateway user name and password. 

Multiple Filing Credentials 

 

You can store multiple filing credentials and save a set of credentials against each Tax 

client.  To set up multiple filing credentials proceed as follows: 

 

 Enable multiple filing credentials: click Tools / Multiple credentials / Enable 

multiple credentials 

 Click Tools / Multiple credentials / Add multiple filing credentials.  The following 

screen is presented: 

 

 
 

 Click Add, enter the name in the agent/office name field 

 If you are submitting as an agent tick the Submit as an agent box 
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 Tick the types of submission your credentials cover (SA100, SA800 or both) 

 Enter the user ID and password 

 Click Save 

 

To apply credentials to a client record: 

 

 Click Submit on the main toolbar 

 In the Internet filing management screen click the Add details button 

 Click the dropdown button and select the set of credentials you wish to use for 

this return, click Select: 

 

 
 

 Click Continue 

Checking the Return 

 

Click Check to check the tax return for errors prior to filing.  Click Next, the following 

screen is displayed: 
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You can see from the example above that there are a number of errors and warnings.  

Errors must be resolved before attempting to file, notice that the Next button is disabled 

at this stage and will not be enabled until the errors are resolved.  To see the error 

details click the Details button, the screen looks like this: 

 

You can filter the results by clicking Pass, Warn or Fail or any combination of those in the 

bottom right.  To resolve errors, double click the error to drill down into the relevant 

section of the return.  Click Print to produce a report listing the errors, which also gives 

further details of the problem and is useful where there are a number of errors.  Click 

Return to go back to the main validation screen.   
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Attachments 

 

Click the Attachments button to manage attachments to the return.  The following 

screen is presented: 

 

A file is created within the Tax folder.  To attach a file, click the browse button to the 

right of the Selected File field, navigate to the file location and click Open.  The path and 

file name will appear in the Attachment frame.  Click Attach and the file will appear in 

the Added Attachments frame.  To preview the file, double click it.  Click Exit to return to 

the main Internet Filing Management screen.  

 

Printing the Declaration and Submitting the Return 

 

Once you have resolved any errors you will be able to proceed to filing, to print a hard 

copy declaration click the Print HC Declaration button.  To submit the return, click the 

Submit button.  Tax will attempt to contact the gateway and submit the return; you will 

see the progress on screen as this happens.   

Once you start to submit returns a log of submissions and their results will start to build 

up.  To access the history click the History button in the Internet Filing History Options 

frame, or click the History (All) to see a history of all tax returns.  

Check the various options in the Status frame to record the various stages of filing 

completeness.  
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Partnerships 
 

So far we have looked at self assessment returns; in this section we will highlight the 

differences between self assessment and partnership returns.   

Creating Partnership Returns 

 

When working with partnership or LLP records in Client Manager, SA800 jobs will be 

available to add to the client record.  Adding an SA800 job will create the SA800 in the 

Tax module.  When you open the return in the Tax module, you will be prompted for 

additional details about the partnership.  Proceed as follows: 

 The partnership name will appear in the Personal tab 

 Click Personal details continued, if you entered the partnership UTR on the Client 

Manager record it will be present in this tab. The UTR is essential for filing and 

you should add it as soon as it is known.  Adding the UTR in Tax will add the UTR 

to the Client Manager record 

 Click the Supplementary pages tab; tick the supplementary pages required and 

add the number of copies 

 

Adding and Maintaining Partners 

 

The partners contained in the partnership statement (page 6 onwards) of the SA800 can 

be linked and profits transferred to the SA104 pages of the SA100.   

 

Of course, an individual may be a partner in more than one partnership and as a 

consequence have more than one set of SA104 pages.  It is important, therefore, to 

ascertain the correct set of SA104 pages to link to in each return.   

 

To add partners and link to SA104 pages, you must first ensure that the SA100s of the 

individual partners contain the correct type (short of full) and number of SA104 

supplementary pages. The SA800 with a full partnership statement can only be linked to 

the full SA104.  Likewise, the SA800 with a short version of the partnership statement 

can only be linked to the short SA104.  To add partners, proceed as follows: 

 

 Click the Client button on the main toolbar in the SA800, click the Partners tab.  

The screen looks like this: 
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 In the group headed 2014 Partners you will see all 2014 self assessment returns 

that have partnership pages that match the type of partnership statement (short 

of full). Click the partner on the right and click Add to link the individual to the 

partnership return.   

 Tax can apportion the partner’s share of profit in the return; the partner’s profit 

share can also be seen in the partner’s pages or the partnership statement. The 

system will handle any rounding differences to balance the partners’ share by 

placing any difference to the first partner listed.  To allocate a percentage of 

profit to a partner click Edit (after allocating the partner) and enter the partner’s 

percentage share in the profit allocation field. 

 You can also add a new partner, and optionally create a return for the individual 

by clicking New; you will be prompted to create a return for the individual, which 

can be completed as required. 

 

Linking a Partner with Multiple SA104 Copies 

 

An individual may be a partner in multiple partnerships.  It is important, therefore, to 

ensure you link the partner’s details to the correct copy of the SA104. 

To link a partner with multiple SA104 copies: 

 Click Client on the main toolbar in the SA800 

 Click the Partners tab 

 Click the Partner in the Selected Partners list and click Edit 

 Click the dropdown button in the SA104 linking field and select the SA104 copy to 

link to. 

 Click Save 
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Transferring Profit to SA104 Pages 

 

On the main tool bar at the top right of the screen there is a Transfer button, clicking 

this will transfer relevant data from the partnership return to the individual return. 

 

 

Click the Transfer button, the following screen is presented: 

 

Click Transfer to transfer the profit to the SA104. 

 

Backing up and Restoring Data 
 

To backup data, if you have Tax Professional you have two options: 

1. Backup data by clicking the Start button on the main toolbar in Tax, click the Utils 

tab and click Backup/restore, follow the instructions on screen to backup (or 

restore) all returns, a selection or an individual return. 

2. Backup data by closing Tax and clicking the Windows Start button on your 

computer, click All Programs, Keytime, Tax 2014, Utils, Backup.  Click Backup (or 

restore), follow the instructions on screen to back up ALL returns. 

 

If you have Tax Personal, only option 2 above is available to you. 

 


